
About Norton System Doctor
Norton System Doctor helps keep your computer free of problems and running at peak efficiency. By default, Norton
System Doctor runs quietly in the background, continually monitoring your computer's operating environment. It 
can alert you immediately when conditions require attention, and can fix many problems automatically, without 
interrupting your work.
While the default settings are ideal for most users, Norton System Doctor is completely customizable. You can 
specify what conditions Norton System Doctor monitors, and control what happens when problems are detected.
Norton System Doctor:

Uses Sensors to monitor just about every aspect of your computer system, including the disks, memory, 
CPU, and network. 

Has Alarms that trigger when a condition being monitored reaches a critical value.
Lets you customize its configuration.

Click here 
{button ,AL("SYSDOC32_I0010;SYSDOC32_I0430;SYSDOC32_I0370;SYSDOC32_T0080;SYSDOC32_T0440;SYSDOC32
_I0030;SYSDOC32_I0020;SYSDOC32_I0050;SYSDOC32_I0040;SYSDOC32_T0010;SYSDOC32_T0430")} for related 
information. 



Why you should use Norton System Doctor
Norton System Doctor can alert you to critical system conditions before problems occur. Some of the most helpful 
sensors in this regard are:

Disk Integrity sensor continuously monitors the file allocation table, directory structure, and compressed
disk structures (if any) of the selected disk. If problems are detected, Norton System Doctor can open Norton Disk 
Doctor to make repairs before your files are damaged.

Disk Surface sensor monitors the disk surface for problems, and, like the disk integrity sensor, can open 
Norton Disk Doctor to make repairs immediately.

Disk Image Information and Rescue Readiness sensors monitor how long it has been since you last 
ran Image and Rescue. It is important to keep the data stored in your disk's image and in your rescue disk set 
current. These sensors can remind you to refresh this information periodically, or automatically refresh it for you. 
Computer failures can cause data to be lost or corrupted; your rescue disks can help you recover your data quickly. 
Your disk's image stores a copy of file-location information that can help you recover deleted files and directories.

Disk Fragmentation sensor keeps your disk optimized by monitoring the degree of file fragmentation on
a disk, and can run Speed Disk automatically when the disk becomes too fragmented.

Disk Space and Virtual Memory sensors alert you when you're running low on disk space and memory
before file operations fail and you're forced to close applications.

Battery Power sensor warns you when a portable computer's battery is low.
Disk SMART Status sensor monitors the status of your drive hardware, and can warn you of an 

imminent drive failure.
Virus Scan sensor scans your system for viruses. If viruses are detected, and you have Norton AntiVirus 

installed on your system, it can start Norton AntiVirus automatically to remove them.
Virus Definitions sensor alerts you when your virus definitions should be updated. Virus definitions files 

are used by the Virus Scan sensor and by Norton AntiVirus to identify and remove viruses from your system.
Norton System Doctor also provides the information you need to fine-tune the performance of your computer. For 
example, the Cache Throughput, Cache Hits, and Cache Size sensors help you analyze the effectiveness of your 
disk cache. The Virtual Memory, Swap File Size, and Swap File Utilization sensors let you see how much virtual 
memory your system is using at any time. A combination of these and other sensors can help you determine why 
your computer is running slowly or analyze the impact of particular operations on performance.
In addition, specialized uses of Norton System Doctor are almost limitless for software developers, hardware 
purchasing departments, network administrators, and other advanced users.
Click here 
{button ,AL("SYSDOC32_I0010;SYSDOC32_I0100;SYSDOC32_I0160;SYSDOC32_I0170;SYSDOC32_I0180;SYSDOC32_I
0190;SYSDOC32_I0230;SYSDOC32_I0290;SYSDOC32_I0040;SYSDOC32_I0030")} for related information.



When you should use Norton System Doctor
To take advantage of Norton System Doctor's powerful features, you should have it running at all times. At the very 
least, the default sensors should be kept active to monitor your computer's critical systems. Other sensors are 
designed for occasional performance tuning of your system and for specialized uses.
You can have Norton System Doctor start automatically whenever you start Windows, and optionally run minimized.
From the View menu, choose Options and click the Window Settings tab.
You also can use Norton System Doctor when you first purchase or upgrade a computer to get an initial measure of 
its performance.
Click here 
{button ,AL("SYSDOC32_I0010;SYSDOC32_T0420;SYSDOC32_T0430;SYSDOC32_I0040;SYSDOC32_I0020")} for 
related information.



Types of sensors
The Norton System Doctor sensors fall into the following general categories:

Memory sensors
Disk sensors
System sensors
Internet/Network sensors
Performance sensors
Information sensors

Depending on the type of information displayed, Norton System Doctor uses three different sensor formats:
Graph Sensors

This type provides a real-time display of values. Most Norton System Doctor sensors are of this type. You can 
display graph sensors as analog gauges, bar gauges, histograms, or digital readouts. The bar, analog, and digital 
formats show only the current reading, whereas the histogram shows several measurements collected over a period
of time.

You can display a history window from most graph sensors' context menus. This window provides a larger 
histogram display detailing current, minimum, and maximum values encountered since the sensor was added or 
since it was last reset.

Stop light sensors
These sensors generally check the system at specified intervals and report the results as green, yellow, or red 

"traffic" signals. For most of these sensors, Norton System Doctor can run an appropriate program automatically to 
correct problems it detects.

Calendar sensors
The Windows Up Time and Current Date & Time sensors display calendars.

Most sensors let you display their information in one of two ways. For example, by default the CPU Utilization sensor
displays the proportion of time the CPU is in use. If you wish, this sensor can instead display the proportion of time 
that the CPU is idle.
Click here {button ,AL("SYSDOC32_I0360;SYSDOC32_I0390;SYSDOC32_I0400;SYSDOC32_I0410")} for related 
information.



Types of disk sensors
Norton System Doctor includes sensors that monitor disk drive conditions and, in some cases, can fix problems:

Disk Fragmentation
Disk Image Information
Disk Integrity
Disk Slack Space
Disk SMART Status
Disk Space
Disk Surface Test
For all of these sensors, set up a separate instance of the sensors for each drive you want to monitor.

In addition, you can set up a Windows Performance Stats sensor to obtain more information about virtual memory 
usage.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_T0300;SYSDOC32_I0050")} for related information.



Types of information sensors
Norton System Doctor includes sensors that can help you gather information about your system:

Current Date and Time
HealthyPC
Norton Protected Files
Norton Utilities LiveUpdate
Windows Up Time

Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0050")} for related information.



Types of memory sensors
Norton System Doctor includes a number of sensors related to memory usage:

DOS Memory
GDI Resources
Memory Load
Physical Memory
Selectors (16-bit)
Swap File Size
Swap File Utilization
System Memory
User Resources
Virtual Memory

You can use any of these sensors' context menus except for DOS Memory and Selectors (16-bit)
to open the Memory tab of System Information for additional memory information. In addition, you can set up 

Windows Performance Stats sensors to obtain more information about virtual memory usage.
The memory sensors let you monitor memory usage in real time. As you open, use, and close applications, you can 
see the effect on memory availability. You can thereby isolate the applications, or the operations within those 
applications, that consume large amounts of memory.

You may want to set up two instances of memory sensors (as well as other sensors)
one to track historical trends and the other to monitor current readings.

Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0050")} for related information.



Types of Internet and network sensors
Norton System Doctor includes sensors that can monitor your network connection:

Internet Packet Turnaround
Internet Speedometer
Network Reads Throughput
Network Writes Throughput

Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0050")} for related information.



Types of performance sensors
Norton System Doctor includes sensors that can monitor the performance of your disk cache and monitor various 
Windows performance statistics:

Cache Hits
Cache Memory Utilization
Cache Throughput
Windows Performance Stats

The cache sensors can help you fine-tune your computer, analyze the performance of its disk cache, and make 
upgrade decisions. For example, if the cache is always small, if the cache hits rate is low, or if the cache is slow, you
might consider installing additional RAM in your computer. In general, a large disk cache increases the cache hits 
ratio and cache speed; however, the cache also reduces the amount of RAM available to other applications and 
processes. The size of the disk cache is controlled by Windows itself to balance the needs of the system with the 
amount of RAM installed on your computer. The only way to potentially increase the size of the disk cache is to 
install more RAM on your machine.
The Windows Performance Stats sensors let you tap in to Windows own recordkeeping functions to follow the 
performance of various aspects of your system.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0050")} for related information.



Types of system sensors
Norton System Doctor includes sensors that can monitor the performance of your system:

Battery Power
CPU Utilization
Open Files
Rescue Readiness
Threads
Virus Definitions
Virus Scan

Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0050")} for related information.



About the Battery Power sensor
If you have a portable computer that lets you use a battery (instead of AC electrical current) as its source of power, 
you can use this sensor to monitor how much charge your battery has. You can set up this sensor to display the 
percentage of battery power used or available.
If you keep this sensor visible, over time you can get an idea about how much work you can do before your battery 
will need recharging. You should check the current charge level before starting an operation that consumes power 
quickly (for example, file transfers or any operation that involves long or frequent accesses of a drive). If you want 
to set the alarm for the Battery Power sensor, consider the type of work you're doing, your previous experience with
the frequency of recharges, and the age of the battery to determine an appropriate alarm level.
This sensor requires your computer's battery power source to be compliant with Microsoft's Power Management API.
If your computer does not include a battery that can be used as the power source, this sensor always registers 0.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0050")} for related information.



About the Cache Hits sensor
This sensor monitors how much of the data that your applications need to access comes from your system's disk 
cache rather than from disk. A "cache hit" means the disk cache was able to supply the required data, whereas a 
"cache miss" means the data had to be retrieved from disk. Because a computer can access data from a disk cache 
much more quickly than it can from the disk itself, a high cache hits rate is desirable.
If your computer requested data from disk 10,000 times and 7,500 of those times the data was available in the 
cache, your cache hits rate would be 75%. Many computers can achieve a cache hit rate of 99%. A low percentage 
of cache hits may indicate one or more of the following conditions:

A large number of processes may be accessing data at the same time.
The data on the disk may be very fragmented.
Your system's disk cache may be small. (The Windows 95 disk cache dynamically allocates and de-

allocates memory based on current system requirements, so the size of the disk cache changes constantly.)
If you choose to display the cache miss percentage rather than the cache hit percentage, the name of this sensor 
changes to Cache Misses.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0080")} for related information.



About the Cache Memory Utilization sensor
This sensor monitors your system's usage of its disk cache. By default, this sensor displays the amount of physical 
memory (RAM) currently used for the cache. The measurement can be expressed in megabytes, kilobytes, bytes, or 
as a percentage of the maximum cache size the sensor has recorded for your computer. You can also use this 
sensor's context menu to open System Information to get details about your current memory usage.
Windows dynamically adjusts disk cache size to meet the changing demands on your computer's memory. Before 
changing the default alarm value for this sensor, determine an appropriate alarm level by considering the type of 
work you're doing and the amount of memory typically available. Work that involves frequent storage and retrieval 
of information stored on disk can benefit from a large disk cache, unless other demands on memory are also high 
(for example, because many applications are open). 
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0050;SI32_I0010")} for related information.



About the Cache Throughput sensor
This sensor measures the speed at which your computer is able to handle requests for data stored on disk. The 
measurements take into account both the speed of your system's memory and the speed of disk accesses. You can 
configure this sensor to display the speed in megabytes, kilobytes, or bytes per second. The higher the speed this 
sensor reports, the more effective is your system's disk cache.
A low cache throughput reading may indicate one or more of the following conditions:

A large number of processes may be accessing data at the same time.
The data on the disk may be very fragmented.
Your system's disk cache may be small. (The Windows disk cache dynamically reserves and frees memory 

based on current system requirements, so the size of the disk cache changes constantly.)
Your system may not have sufficient RAM.
Your system may have a slow disk drive.

Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0440;SYSDOC32_I0080")} for related information.



About the CPU Utilization sensor
This sensor measures how much time your computer's CPU spends executing instructions versus the time it spends 
idle. You can configure this sensor to display the percentage of time that the CPU is either used or free. You can also
use this sensor to open the System tab in System Information to get additional CPU information or to benchmark 
your system.
If the CPU frequently has little or no idle time, an application or other process may be using resources inefficiently 
or you may have too many applications open. This sensor can help you monitor your computer's performance, 
troubleshoot problems, and analyze the performance of particular applications and processes. From this sensor's 
context menu, you can open System Information to get additional information about your CPU.

It is fairly common for the CPU usage to jump to 100% during some operations, such as loading programs 
and some CPU-intensive CAD and spreadsheet operations. Also note that certain 16-bit device drivers loaded from 
CONFIG.SYS or AUTOEXEC.BAT can prevent the CPU utilization from ever falling to a low value.
Click here {button ,AL("SYSDOC32_I0430;SI32_I0010;SYSDOC32_I0050")} for related information.



About the Current Date and Time sensor
This sensor displays the date and time within the Norton System Doctor window. You might find this sensor 
especially useful if you set up Norton System Doctor so it is always on top of other windows.
This sensor always appears in calendar format. You can change the font that this sensor and the Windows Up Time 
sensor use to display the date.
Click here {button ,AL("SYSDOC32_I0050")} for related information.



About the Disk Fragmentation sensor
This sensor shows how fragmented a local disk drive has become. It can automatically open and run Speed Disk to 
defragment disk space, or alert you when fragmentation exceeds a certain percentage. You can set up this sensor 
to display the percentage of the disk space that is either fragmented or unfragmented. You can also control how 
frequently this sensor scans a disk, as well as how long it waits before rescanning if the scan is interrupted or can't 
be started as scheduled because of other system activity.
From the Drive tab of this sensor's Properties you can control how frequently the sensor scans a disk. You can also 
specify how long the sensor should wait before rescanning if a scan is interrupted because of other system activity.

The Disk Fragmentation and Disk Integrity sensors both scan your drives. Norton System Doctor can gather
the information required by both sensors from a single scan. If you change the scan or rescan intervals for a disk 
from one sensor's properties, the intervals for the other sensor are automatically adjusted to match. 
You can use the Disk Fragmentation sensor to open Speed Disk and defragment a disk in any of three ways:

By setting its alarm action to Repair Immediately. If the disk reaches the percent of fragmentation specified
in the alarm properties, this sensor automatically runs Speed Disk in the background.

By setting its alarm action to Display Recommendation. If the disk reaches the percent of fragmentation 
specified in the alarm properties, this sensor displays a recommendation dialog box and gives you the option of 
opening Speed Disk in the foreground.

By choosing Open Speed Disk from this sensor's context menu to open Speed Disk in the foreground.
Defragmenting a disk increases the speed at which it can read and write files. The more you create, modify, copy, 
or delete files, the more quickly the disk becomes fragmented.

Add a separate Disk Fragmentation sensor for each disk you want to monitor. In addition to hard disks, this 
sensor can monitor high-capacity, removable media, such as Iomega's Zip

 and Jaz
 drives.

Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0060;SYSDOC32_I0180;SD32_I0010")} for related 
information.



About the Disk Image Information sensor
This sensor shows a "traffic signal" indicating how much time has elapsed since you last ran Image. Image takes a 
"snapshot" of critical disk information for a local disk drive. This information can be used to unformat a disk and can
help to unerase files or folders. You should run Image frequently to keep your disk's image current. The Disk Image 
Information sensor can run Image automatically for you or alert you when a given amount of time has elapsed since
Image was last run.
One of the properties of the Disk Image Information sensor is how often Image should be run to update the disk 
information. A green light indicates Image has been run within the specified period of time, a yellow light indicates 
the elapsed time exceeds 90% of the specified time period, and a red light indicates the time period has expired.
You can use this sensor to open Image and update the disk information in any of three ways:

By setting its alarm action to Repair Immediately. If the time period specified in the alarm properties 
expires, this sensor automatically runs Image in the background.

By setting its alarm action to Display Recommendation. If the time period specified in the alarm properties 
expires, this sensor displays a recommendation dialog box and gives you the option of opening Image in the 
foreground.

By choosing Open Image from this sensor's context menu to open Image in the foreground.
Before changing the default trigger level of this sensor, consider the type of work you're doing. The more you 
create, modify, copy, or delete files, the more frequently you should run Image.

Add a separate Disk Image Information sensor for each disk you want to monitor. In addition to hard disks, 
this sensor can monitor high-capacity, removable media, such as Iomega's Zip

 and Jaz
 drives. Use the Disk Fragmentation sensor to keep the disk from becoming highly fragmented, because 

fragmentation makes recovery of erased files and folders more difficult.
Click here {button ,AL("IW_I0010;SYSDOC32_I0430;SYSDOC32_I0060")} for related information.



About the Disk Integrity sensor
This sensor monitors the condition of a local disk drive. It can automatically run Norton Disk Doctor if problems are 
detected, or else display a warning message alerting you to the problems.
Like Norton Disk Doctor, this sensor inspects the file allocation table for errors, and checks for cross-linked files and 
lost clusters. The sensor displays a "traffic signal" to indicate the scan results: a green light indicates no problems 
were detected, a yellow light indicates lost clusters were the only problem detected, and a red light indicates more 
severe problems were detected.

Unlike Norton Disk Doctor, this sensor does not check the boot sector, the disk surface, the partition table, 
or compressed drives. Use the Disk Surface Test sensor to periodically check the surface of your disks.
From the Drive tab of this sensor's Properties you can control how frequently the sensor scans a disk. You can also 
specify how long the sensor should wait before rescanning if the scan is interrupted because of other system 
activity.

The Disk Integrity and Disk Fragmentation sensors both scan your drives. Norton System Doctor can gather
the information required by both sensors from a single scan. If you change the scan or rescan intervals for a disk 
from one sensor's properties, the intervals for the other sensor are automatically adjusted to match. 
You can use the Disk Integrity sensor to open Norton Disk Doctor in any of three ways:

By setting its alarm action to Repair Immediately. If the sensor light turns red, this sensor automatically 
runs Norton Disk Doctor in the background.

By setting its alarm action to Display Recommendation. If the sensor light turns red, this sensor displays a 
recommendation dialog box and gives you the option of opening Norton Disk Doctor in the foreground.

By choosing Open Norton Disk Doctor from this sensor's context menu to open Norton Disk Doctor in the 
foreground.
Because the disk integrity scan can minimize the problems resulting from a disk failure, it's a good idea to let this 
sensor scan your disks frequently.

In addition to hard disks, this sensor can monitor high-capacity, removable media, such as Iomega's Zip
 and Jaz
 drives.

Click here {button ,AL("NDD32_I0010;SYSDOC32_I0430;SYSDOC32_I0200;SYSDOC32_I0160;SYSDOC32_I0060")} for
related information.



About the Disk Slack Space sensor
This sensor shows the amount of slack space on a disk.
The operating system allocates (reserves) space for files in discrete chunks called "clusters." Most files, however, 
occupy less physical space on the disk than the operating system has reserved. Slack is the excess space allocated 
for a file—space that remains unoccupied by any of that file's data. Once allocated for a particular file, disk space 
cannot be used for any other purpose, so slack space is essentially wasted space. Using a smaller cluster size, as 
you can do with the FAT32 file system, can help minimize disk slack space.
Click here {button ,AL("SYSDOC32_I0060;SYSDOC32_I0190")} for related information.



About the Disk SMART Status sensor
This sensor shows when a disk drive failure is imminent. This sensor only supports drives that have SMART built-in.
Self-Monitoring And Reporting Technology (SMART) is built in to newer hard drives. It allows these drives to monitor 
their own operation and predict most drive hardware failures before they occur. With this warning, you can back up 
your files and replace or repair your drive before losing valuable data.
Click here {button ,AL("SYSDOC32_I0180")} for related information.



About the Disk Space sensor
This sensor monitors usage of any local hard drive or network drive to which you have access. This sensor helps you
anticipate low disk space conditions so that you don't run into problems while running applications, creating, or 
copying files. You can also use this sensor's context menu to open System Information to get additional information 
about your disks.
By default, the sensor displays the amount of free disk space; you can optionally configure the sensor to display the
amount of used disk space. The measurement can be expressed in megabytes, kilobytes, bytes, or as a percentage 
of the disk's total space.
By default, this sensor's alarm is triggered when the available disk space falls below five percent of the total disk 
space. If you want to change the alarm's trigger level, consider the type of work you're doing and the amount of 
disk space currently available. For example, if you're using a multimedia or graphics application, creating large 
documents, or working with a large database, you can quickly consume large amounts of disk space.

Add a separate Disk Space sensor for each disk you want to monitor. In addition to hard disks, this sensor 
can monitor high-capacity, removable media, such as Iomega's Zip

 and Jaz
 drives. If you're a network administrator, you can use Disk Space sensors to track usage of network drives.

Click here {button ,AL("SYSDOC32_I0430;SI32_I0010;SYSDOC32_I0060;SYSDOC32_I0184")} for related information.



About the Disk Surface Test sensor
This sensor scans the surface of a local disk. It can automatically run Norton Disk Doctor if a surface problem is 
detected, or else alert you to the problem. While a surface scan usually monopolizes computer resources for a good
deal of time, this sensor does not interfere with other system activity. Instead, it uses the CPU's idle time. When 
other activity interrupts the scan, this sensor later resumes the scan at the location where the interruption 
occurred. This sensor displays the percentage of the scan that has been completed.
You can use the Disk Integrity sensor to open Norton Disk Doctor in any of three ways:

By enabling its alarm and setting it to Take Immediate Action. If the alarm condition occurs, this sensor 
automatically runs Norton Disk Doctor in the background.

By enabling its alarm and setting it to Display Recommendation. If the alarm condition occurs, this sensor 
displays recommendations and gives you the option of opening Norton Disk Doctor in the foreground.

By clicking Open Norton Disk Doctor on this sensor's context menu to open Norton Disk Doctor in the 
foreground.
Because the surface scan can be interrupted and resumed, it doesn't appreciably degrade overall system 
performance. And because the scan can minimize the problems resulting from disk failures, it's a good idea to set 
this sensor to scan every few minutes.

Add a separate Disk Surface Test sensor for each disk you want to scan for surface errors. In addition to 
hard disks, this sensor can monitor high-capacity, removable media, such as Iomega's Zip

 and Jaz
 drives. If you're a network administrator, you can use Disk Surface Test sensors to track usage of network drives. 

The Disk Surface Test sensor cannot monitor floppy disks.
Click here {button ,AL("NDD32_I0010;SYSDOC32_I0430;SYSDOC32_I0060;SYSDOC32_I0180")} for related 
information.



About the DOS Memory sensor
This sensor monitors the availability of conventional memory on your computer. You can set up this sensor to 
display how much DOS memory is either free or used. The measurement can be expressed in kilobytes or bytes, or 
as a percentage of the total DOS memory.
Windows loads into the DOS memory region any real-mode, DOS-based device drivers your system may require. 
The CONFIG.SYS and AUTOEXEC.BAT files specify the real-mode drivers to be loaded. Some applications designed to
run under Windows 3.x use the DOS memory region, and real-mode drivers reduce the amount of memory available
to such applications. (Windows 95 replaces most real-mode drivers with new virtual device drivers, so your system 
may not use any real-mode drivers. The CONFIG.SYS and AUTOEXEC.BAT files are necessary only if you need to load
real-mode drivers.)
Note that DOS memory is not the same as the memory available when you use Windows 95 to open a DOS window. 
Some older 16-bit programs allocate DOS memory; this sensor reports the amount of memory available for such 
allocations.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0070")} for related information.



About the GDI Resources sensor
This sensor measures the usage of Graphics Device Interface (GDI) resources. You can set up this sensor to display 
the percentage of GDI resources that are either used or free. You can also use this sensor to open the Memory tab in
System Information to get details about your computer's memory and current memory usage.
To run applications, Windows requires free GDI resources, User resources, and (for Windows 3.x applications) 
selectors. If these requirements are not met, additional applications cannot be opened; if running applications 
exhaust these resources, you will receive out-of-memory errors and will need to close one or more applications.
Compared to earlier versions of Windows, Windows 95 greatly expands and enhances GDI resources, in part by 
providing some of the most memory-intensive operations through new, 32-bit code. For example, spooling, printing,
font-drawing, and many graphics operations now use 32-bit code.
Some GDI resources continue to be provided through the older, 16-bit code, which ensures compatibility for DOS 
applications and applications designed to run under Windows 3.x. However, the 16-bit code retains a number of the 
limitations of Windows 3.1. Because every window and dialog box that gets displayed requires GDI resources, they 
are still somewhat limited, especially if you run mostly 16-bit applications.
Click here {button ,AL("SYSDOC32_I0430;SI32_I0010;SYSDOC32_I0320;SYSDOC32_I0300;SYSDOC32_I0070")} for 
related information.



About the HealthyPC sensor
The HealthyPC sensor reminds you to check HealthyPC.com regularly for new computer tips, advice, and free 
software samples provided by Ziff-Davis.    While you're there, join the HealthyPC.com Health Club.
As a Club member, you have access to VitalCheck and LiveUpdate:

VitalCheck provides a comprehensive computer checkup that detects viruses and hard disk problems. By 
repairing file viruses, including Word macro viruses, VitalCheck complements the data protection that Norton 
Utilities provides.

LiveUpdate searches your system for installed hardware and software, and can automatically update your 
computer with the latest software updates, bug fixes, and hardware drivers. Using LiveUpdate, you can update your
software and drivers as easily as Norton System Doctor updates your Norton Utilities and virus definitions files.
Club members also have access to special promotions, contests, virus information, and free support.
Click here {button ,AL("SYSDOC32_I0050")} for related information.



About the Internet Packet Turnaround sensor
This sensor shows the speed of Internet packet transmission between your computer and an Internet site of your 
choice. You can select a site (host name or IP address) from the Site tab of this sensor's Properties. To monitor more 
than one site, add multiple Internet Packet Turnaround sensors.



About the Internet Speedometer sensor
This sensor shows the speed of your connection to an Internet site of your choice. This sensor's alarm can notify you
when transmission speeds are acceptably fast. (Note that a smaller time value in this case means a faster 
transmission speed.)
You can select a site (host name or IP address) from the Site tab of this sensor's Properties. To monitor more than 
one site, add multiple Internet Speedometer sensors.



About the Memory Load sensor
This sensor monitors usage of the combination of your computer's physical memory (RAM) and the virtual memory 
provided by the Windows swap file. You can set up this sensor to display how much memory is either free or used. 
The measurement is expressed as a percentage of the total physical plus virtual memory. You can also use this 
sensor to open the Memory tab in System Information to get details about your computer's memory and current 
memory usage.
Windows first uses most of the available physical memory. If applications require additional memory, Windows 
creates a swap file on your hard drive. The more free disk space you have, the bigger the swap file can be. The 
Memory Load sensor can help you optimize your computer's performance and make upgrade decisions. For 
example, if the memory load is often high, you may want to free up disk space or install additional RAM. 
Applications run faster when they are using physical memory rather than virtual memory.
If you want to set the alarm for this sensor, determine an appropriate alarm level by considering the type of work 
you're doing and the amount of memory typically available. For example, if you have a number of applications open
at one time, your normal memory load will be quite high.

If you want to know when your computer first runs out of free physical memory and starts using virtual 
memory, set up the Virtual Memory sensor to trigger the alarm when the amount used is very small.
Click here {button ,AL("SYSDOC32_I0430;SI32_I0010;SYSDOC32_I0070")} for related information.



About the Network Reads Throughput sensor
This sensor measures the speed at which your system reads data from a Novell network drive. The speed can be 
expressed in megabytes, kilobytes, or bytes per second.
This sensor helps you evaluate the performance of your network card and other network hardware. You can also use
this sensor's context menu to open System Information to get additional network information.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0440;SI32_I0010;SYSDOC32_I0450;SYSDOC32_I0050")} for 
related information.



About the Network Writes Throughput sensor
This sensor measures the speed with which your system writes data to a Novell network drive. The speed can be 
expressed in megabytes, kilobytes, or bytes per second.
This sensor helps you evaluate the performance of your network card and other network hardware. You can also use
this sensor's context menu to open System Information to get additional network information.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0440;SI32_I0010;SYSDOC32_I0450;SYSDOC32_I0050")} for 
related information.



About the Norton Protected Files sensor
This sensor shows the number of files currently stored in the Norton Protected Recycle Bin; these files are currently 
under Norton Protection. Norton Protection enhances the file recovery capabilities offered by the Recycle Bin by 
protecting overwritten files, files deleted from within a Windows application, and files deleted from a DOS window. 
As long as these files are protected, they can be retrieved intact after their deletion.



About the Norton Utilities LiveUpdate sensor
This sensor reminds you to check for updates to Norton Utilities. The sensor can launch Symantec's LiveUpdate 
program which downloads updates to Norton Utilities directly from Symantec Corporation if you have an Internet 
connection.



About the Open Files sensor
This sensor monitors the number of files that are currently open on any local hard drive or network drive to which 
you have access. Windows applications and processes open files during normal execution. With Windows 95, there 
is no longer a system limit to the number of files that can be open at the same time; however, a large number of 
open files can slow down your computer.
This sensor can help you analyze the performance of your computer as well as of particular applications (especially 
database applications, since they often open many files). A large number of open files might explain, for example, 
poor disk cache performance. If you want to set the alarm for this sensor, consider the type of work you're doing to 
determine an appropriate alarm level.

Add a separate Open Files sensor for each disk you want to monitor.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0440;SYSDOC32_I0060")} for related information.



About the Physical Memory sensor
This sensor monitors usage of your computer's physical memory (RAM). Applications run faster when they are using
physical rather than virtual memory. This sensor can help you optimize your computer's performance and make 
upgrade decisions.
By default, this sensor shows the amount of available (free) RAM; if you want you can set the sensor to show the 
amount of RAM that is currently in use. The sensor can express RAM usage in megabytes, kilobytes, bytes, or as a 
percentage of the total RAM installed on your system. You can also use this sensor's context menu to open System 
Information to get more details about your computer's current memory usage.

Physical memory includes a variable-size cache, which generally uses most of the free memory, therefore 
most of the physical memory is usually in use. The cache size is automatically reduced as physical memory is 
needed for other purposes.
Click here {button ,AL("SYSDOC32_I0430;SI32_I0010;SYSDOC32_I0070")} for related information.



About the Windows Performance Stats sensors
These sensors can show the various performance statistics provided by Windows. The sensors monitor the same 
types of information reported by the Windows System Monitor program. You can add multiple sensors to monitor 
different types of performance data. Some of this information duplicates native System Doctor sensors, however 
Windows Performance Stats sensors do not include alarms.
At minimum, this sensor provides access to three categories of performance statistics:

File System
Measurements of reading and writing operations

Kernel
Number of virtual machines that are running, number of threads that are running, and processor usage 

percentage
Memory Manager

Measurements relating to the Windows swap file and virtual memory management
Depending upon your system, network and other additional categories may also be available.
The Items To Monitor tab of this sensor's property sheet lists each category of information available, the 
performance items in each category, and a description of each. It also displays the item titles for the large and 
small style sensors; you can change these titles, if you want.
Some of the Windows Performance Stats items provide the same information as do other Norton System Doctor 
sensors (for example, the Threads, Processor Usage, and Disk Cache Size items); however, the alarm feature is not 
available for Windows Performance Stats sensors.

Add a separate Windows Performance Stats sensor for each item of information that you want to monitor.
Click here {button ,AL("SYSDOC32_I0450;SYSDOC32_I0050")} for related information.



About the Rescue Readiness sensor
This sensor shows a "traffic signal" indicating how much time has elapsed since you last created ran Rescue. 
Rescue creates "rescue disks," which are disks that can restore corrupt or lost system information in the event of a 
computer failure. You should run Rescue Disk every time you add, modify, upgrade, or remove hardware or 
software. The Rescue Readiness sensor can automatically run Rescue Disk for you periodically, or else alert you 
when a certain amount of time has elapsed since Rescue was last run.
From the Alarm tab of this sensor's Properties dialog box, you can specify how old your rescue information can 
become before the alarm is triggered. A green light indicates Rescue Disk has run within the specified period of 
time. A yellow light indicates 90% of the time period has passed, and you should consider updating your rescue disk
set. A red light indicates the time period has expired, and the sensor can remind you to run Rescue Disk or run it for
you.
You can use this sensor to open Rescue Disk in any of three ways:

By enabling its alarm and setting it to Take Immediate Action. If the time period specified in the alarm 
properties expires, this sensor automatically runs Rescue Disk in the background.

By enabling its alarm and setting it to Display Recommendation. If the time period specified in the alarm 
properties expires, this sensor displays recommendations and gives you the option of opening Rescue Disk in the 
foreground.

By clicking Open Rescue on this sensor's context menu to open Rescue Disk in the foreground.
If you want to set the alarm for this sensor, consider using the alarm to ensure that Rescue Disk runs more 
frequently than hardware and software changes occur.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0050;RESCUE32_I0010")} for related information.



About the Selectors (16-bit) sensor
This sensor reports on the usage of selectors, which 16-bit applications and processes require for memory 
management. You can set up this sensor to display the number of selectors that are either used or free.
A finite number of selectors (8192) are available for 16-bit applications to use, and some applications use hundreds 
of selectors. When the selectors are all consumed, you receive messages indicating you are out of memory or 
resources. This sensor lets you track the availability of selectors before such messages appear. 
The newer 32-bit applications do not consume selectors, because they manage memory in a fundamentally 
different way.
If you want to set the alarm for this sensor, a good alarm level is 90% usage (7373 selectors used or 819 selectors 
free).
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0220;SYSDOC32_I0320;SYSDOC32_I0070")} for related 
information.



About the Swap File Size sensor
This sensor shows the amount of disk space currently reserved for use by the Windows swap file. By default, 
Windows dynamically enlarges and reduces this space according to the demands of the system.
The sensor can display the swap file size in megabytes, kilobytes, bytes, or as a percentage of available free disk 
space. You can also use this sensor's context menu to open System Information to get more details about your 
computer's current memory usage.

You can use Windows 95 to designate that a different drive be used for the swap file, or to control the swap
file minimum and maximum sizes. To do so, choose Properties from the context menu of My Computer, click the 
Performance tab, and then click Virtual Memory.
Click here {button ,AL("SYSDOC32_I0306;SYSDOC32_I0330;SYSDOC32_I0430;SYSDOC32_I0070")} for related 
information.



About the Swap File Utilization sensor
This sensor shows how much of the space reserved for the Windows swap file is currently in use for temporary data 
storage. The swap file is used by Windows to manage virtual memory. By default, Windows continuously adjusts the
space reserved for the swap file, according to the demands of the system. This sensor shows you how efficiently 
those demands are being met.
The sensor can display swap file utilization in megabytes, kilobytes, bytes, or as a percentage of the total space 
reserved for the swap file. By default, the sensor shows the amount of reserved swap space that is actually in use 
for data storage; you can set the sensor to show the amount that is currently free if you prefer. You can also use this
sensor's context menu to open System Information to get more details about your computer's current memory 
usage.

You can use Windows 95 to designate that a different drive be used for the swap file, or to control the swap
file minimum and maximum sizes. To do so, choose Properties from the context menu of My Computer, click the 
Performance tab, and then click Virtual Memory.
Click here {button ,AL("SYSDOC32_I0303;SYSDOC32_I0330;SYSDOC32_I0430;SYSDOC32_I0070")} for related 
information.



About the System Memory sensor
This sensor gives you an overview of system memory usage. It combines information monitored by the GDI 
Resources, User Resources, and Virtual Memory sensors. An alarm condition means that at least one of these three 
resources is low. When this sensor turns yellow or red, you should try to close some applications to free up system 
resources.
Click here {button ,AL("SYSDOC32_I0220;SYSDOC32_I0320;SYSDOC32_I0330;SYSDOC32_I0070")} for related 
information.



About the Threads sensor
This sensor monitors the number of threads that are currently running on your computer. You can use this sensor's 
context menu to open System Information to get details about your computer's current memory usage.
New, 32-bit applications, and the 32-bit portion of the operating system itself, have the option of breaking their 
execution into separate tasks or "threads." This ability takes maximum advantage of the CPU's available resources, 
because multi-threaded applications can be faster and more responsive. For example, a multi-threaded application 
can give you the option of canceling a long operation (such as opening a large document) or switching to another 
task while the operation is underway. Multi-threaded applications can also create one thread for a high-priority 
operation (such as responding to keyboard or mouse input) and lower-priority threads for background operations 
(such as repaginating a document or preparing it for printing). However, too many concurrently running threads can
waste memory and slow down the CPU.
The Threads sensor can help you analyze the performance of your computer and evaluate how effectively 32-bit 
applications use multi-threading. If you want to set the alarm for this sensor, determine an appropriate alarm level 
by considering the type of work you're doing and the amount of memory typically available. For example, if you 
have a number of 32-bit applications open at one time, your normal threads usage can be quite high.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_I0440;SI32_I0010;SYSDOC32_I0070")} for related information.



About the User Resources sensor
This sensor measures the usage of User resources. You can set up this sensor to display the percentage of User 
resources that are either used or free. You can also use this sensor to open the Memory tab in System Information 
to get details about your computer's memory and current memory usage.
To run applications, Windows requires free User resources, GDI resources, and (for Windows 3.x applications) 
selectors. If these requirements are not met, additional applications cannot be opened. If running applications 
exhaust these resources, you will receive out-of-memory errors and will need to close one or more applications.
Compared to earlier versions of Windows, Windows 95 increases the availability of User resources, in part by 
providing some of those resources through new, 32-bit code. However, many User resources continue to be 
provided through the older, 16-bit code. Although this older code ensures compatibility for applications designed to 
run under Windows 3.x, it also retains a number of the limitations of Windows 3.1. Because every window and 
dialog box that gets displayed requires User resources, they are still somewhat limited, especially if you run mostly 
16-bit applications.
Click here {button ,AL("SYSDOC32_I0430;SI32_I0010;SYSDOC32_I0220;SYSDOC32_I0300;SYSDOC32_I0070")} for 
related information.



About the Virtual Memory sensor
This sensor reports the amount of available disk space currently unused for temporary data storage. (This amount 
includes space reserved for the Windows swap file that is currently unused for data storage.) You can set up this 
sensor to display utilization in megabytes, kilobytes, or bytes, or as a percentage of the maximum virtual memory 
available. Utilization can be expressed in terms of either free or used virtual memory. You can also use this sensor to
open the Memory tab in System Information to get details about your computer's memory and current memory 
usage.
Applications run faster when they are accessing data from physical rather than virtual memory. This sensor can help
you optimize your computer's performance and make upgrade decisions.

You can use Windows 95 to designate that a different drive be used for the swap file, or to control the swap
file minimum and maximum sizes. To do so, choose Properties from the context menu of My Computer, click the 
Performance tab, and then click Virtual Memory.
The current reading for this sensor is the amount of the swap file currently in use. The maximum reading is the 
amount of free space on the drive (which includes the size of the swap file).
If you want to set the alarm for this sensor, determine an appropriate alarm level by considering the type of work 
you're doing and the amount of memory typically available. For example, if you have a number of applications open
at one time, your normal virtual memory usage will be quite high.

If you want to know when your computer first runs out of free physical memory and starts using the swap 
file, set up the Virtual Memory sensor to trigger the alarm when the amount used is very small.
The    Windows Performance Stats sensors also provide a virtual memory item, in addition to the following swap file 
items under the Memory Manager category:

Swap file size
Swappable memory
Swap file defective

Click here {button ,AL("SYSDOC32_I0303;SYSDOC32_I0306;SYSDOC32_I0430;SI32_I0010;SYSDOC32_I0070")} for 
related information.



About the Virus Definitions sensor
This sensor shows whether your virus definitions files are current. It is critical to have an up-to-date virus definitions
files so that the Virus Scan sensor can identify new viruses. When the definitions become older than 35 days, the 
stoplight turns red and triggers the sensor's alarm, if the alarm is enabled. By default, the alarm action is set to 
display an action recommendation that reminds you to update your virus definitions files.
If you are connected to the Internet, this sensor can use LiveUpdate to get new virus definitions automatically when
they become available. Updated virus definitions files are made available monthly from Symantec Corporation, and 
can also be downloaded from many computer bulletin boards, electronically transferred from Symantec's FTP or 
World Wide Web sites, or mailed to you directly from Symantec Corporation.

Note that a red stoplight does not mean your system is infected with a virus; it means your virus 
definitions files are getting old and that there is probably a new set of definitions available from Symantec 
corporation. This sensor will only turn green when the virus definitions on your machine are younger than the age 
indicated on the Alarm tab of this sensors Properties dialog box; by default, this age is set to 35 days.
Click here {button ,AL(`SYSDOC32_I0338;SYSDOC32_I0500;SYSDOC32_I0510;SYSDOC32_I0520;SYSDOC32_I0530')}
for related information.



About the Virus Scan sensor
This sensor periodically scans your system for computer viruses. The stoplight turns red and the alarm is triggered 
if a virus is found on your system. If you have Norton AntiVirus, this sensor can run it automatically to remove 
viruses. Scanning your system frequently can prevent or minimize the damage that viruses can cause. You can use 
the Files To Scan tab of this sensor's Properties to specify the files to scan for viruses.
From the Drive tab of this sensor's Properties you can control how frequently the sensor scans a disk. You can also 
specify how long the sensor should wait before rescanning if the scan is interrupted because of other system 
activity.
Click here {button ,AL(`SYSDOC32_I0334;SYSDOC32_I0500;SYSDOC32_I0510;SYSDOC32_I0520;SYSDOC32_I0530')}
for related information.



About computer viruses
A computer virus is a self-replicating program, written intentionally to alter the way your computer operates without
your knowledge or permission. Computer viruses are designed to attach themselves to other program files, and 
become activated when those programs are run. While active, a virus replicates by copying itself to other programs 
on any available disk.
Viruses exist in two forms:

Active in your computer’s memory
Lying dormant in files and boot records

Some computer viruses damage the data on your disks by corrupting programs, deleting files, or even reformatting 
the disk.
Just like the effects of biological viruses, effects of computer viruses may be undetectable for days or weeks. Some 
viruses are timed to cause their damage at certain hours of the day or on certain dates. Before a virus does any 
noticeable damage to your system, an infected hard disk can infect disks you insert into your computer’s floppy 
disk drive. Once infected, those floppy disks can infect other computers that read them. And thus the infection can 
spread before any damage is done.
Turning off the computer removes viruses from the memory, but not from disks or files that have been infected. The
next time you use your computer, the virus is activated again and attaches itself to more programs.
There are ways to protect your computer from viruses:

Use the Virus Scan sensor to automatically scan your computer for viruses as you work.
Use the Virus Definition sensor to keep your virus definitions up to date automatically. This ensures that 

your computer is protected against newly discovered viruses.
Purchase and use a good virus detection and removal program, such as Norton AntiVirus.
Make periodic backups of your hard disk.
Buy and use only legal copies of all software you use and make write-protected backup disks.
Keep an updated, write-protected set of rescue disks available to help you recover your system if you’re 

attacked by a virus.
Click here {button ,AL(`SYSDOC32_I0334;SYSDOC32_I0338;SYSDOC32_I0510;SYSDOC32_I0520;SYSDOC32_I0530')}
for related information.



What computer viruses can and cannot do
Viruses can:

Infect program files used for word processing, spreadsheet, or operating system programs and document 
files (such as DOT and DOC files) that contain macros

Infect the information stored on disks by attaching to special programs in areas called boot records and 
master boot records

Corrupt files and data
Viruses cannot:

Damage hardware, such as keyboards or monitors, although strange behavior, such as screen distortion or 
characters not appearing when typed, may occur. If this happens, a virus has affected the programs that control the
display or keyboard.

Damage your disks physically
Infect write-protected disks

Click here {button ,AL(`SYSDOC32_I0334;SYSDOC32_I0338;SYSDOC32_I0500;SYSDOC32_I0520;SYSDOC32_I0530')}
for related information.



Types of computer viruses
The Virus Scan Sensor detects all of the following types of viruses:

Program viruses 
Viruses that can infect program files, such as applications, or operating system programs. 

Boot viruses 
Viruses that can infect boot records or master boot records on disks. When your computer starts, it runs specific 
boot record programs to ready itself for work. Data disks can contain boot viruses too. A virus activates when your 
computer attempts to start from the infected disk. A virus can activate even if your computer can’t start up from 
the infected disk. All boot viruses remain active in memory while your computer is on. While in memory, they 
continue to spread by infecting floppy disks accessed by your computer.

Macro Viruses 
Macros are computer programs that are easily created to repeat a series of actions you do frequently using 
applications like Microsoft Word. Rather than repeating the actions over and over, these applications can record the 
actions as a "macro," and rerun the macro whenever you want.
Macro viruses are written to infect files you create with applications that support macros. These viruses can be 
inadvertently spread to any file you subsequently save using those applications because, in applications like 
Microsoft Word, you can have a macro run automatically whenever Word is started.
Click here {button ,AL(`SYSDOC32_I0334;SYSDOC32_I0338;SYSDOC32_I0500;SYSDOC32_I0510;SYSDOC32_I0530')}
for related information.



The computer virus life cycle
The computer virus has a three-stage life cycle: infection, detection, and recovery.
In the infection stage, a virus infects a file in your computer. Typically, infections comes from a variety of sources:

Reused floppy disks from unknown sources
Floppy disks from home, school, or friends
Programs downloaded from the Internet or a BBS
Opened, re-shrink-wrapped, or pirated software
Preformatted floppy disks

Your computer can be infected when you boot from an infected disk, reboot with an infected floppy disk left in the 
drive, or run an infected program. The virus spreads when you share the disk or infected program or log on to a 
network.
In the detection stage, the virus is identified and isolated. You may notice that your computer is behaving strangely 
or that files are missing or programs are not working. If you are running Norton System Doctor, the virus can usually
be identified by the Virus Scan sensor before damage is done and tell you what files are affected.
In the recovery stage, the virus is eliminated by a virus removal program, like Norton AntiVirus. Unless the virus is 
eliminated, it will continue to infect other files and possibly damage data on your disks. Once you have eliminated 
the virus, you can clean up your computer by re-installing programs from master disks or restore files from an 
uninfected backup. After restoring the programs and data you lost, we recommend you do the following:

Rescan all files to find possible sources of infection, before you run any other programs.
Scan all floppy disks to find possible sources of infection.
Discard backups that may be infected.
Keep Norton System Doctor running, with the Virus Scan and the Virus Definitions sensors active.

Click here {button ,AL(`SYSDOC32_I0334;SYSDOC32_I0338;SYSDOC32_I0500;SYSDOC32_I0510;SYSDOC32_I0520')}
for related information.



About the Windows Up Time sensor
This sensor shows you how much time has elapsed since you last started Windows. This information can be helpful:

If you share a computer
If you experience a power outage
When you are troubleshooting a system
(for example, if a computer frequently needs rebooting)
When you are trying to optimize a system's performance
(for example, if you want to see if there is a correlation between how long a computer has been running 

and when it runs out of memory or other resources)
If your organization has a policy regarding whether users should turn off their computers at the end of the 

day or over the weekend
This sensor always displays in calendar format, showing the days, hours, minutes, and seconds since Windows was 
last started. You can change the font that this sensor and the Current Date and Time sensor use to display the day.
Click here {button ,AL("SYSDOC32_I0050")} for related information.



About Norton System Doctor features
Norton System Doctor includes many powerful features:

Sensor history
Links to other Norton Utilities programs
Ability to hide sensors
Ability to reset sensors or reset Norton System Doctor as a whole
Ability to update sensors
Customization options

Many of these features are particularly useful to network administrators.
Click here 
{button ,AL("SYSDOC32_I0010;SYSDOC32_I0050;SYSDOC32_I0040;SYSDOC32_I0030;SYSDOC32_I0020")} for 
related information.



About sensor history
Most Norton System Doctor sensors include a history window to provide information about sensor readings over 
time. The Windows registry stores each sensor's highest and lowest readings and other measurement information, 
so you won't lose this information when you shut off your computer. You can reset a sensor at any time, causing 
Norton System Doctor to delete its history information from the registry.
 (Some sensors Current Date and Time, Windows Uptime, and the stoplight sensors

have no need for a history window.)
Click here {button ,AL("SYSDOC32_T0050;SYSDOC32_I0390;SYSDOC32_I0400")} for related information.



About the links to other Norton Utilities programs
If their alarms are enabled, some Norton System Doctor sensors can automatically open the appropriate Norton 
Utilities program and correct a detected problem or condition. For example, when a disk becomes fragmented by 
more than a certain percentage the Disk Fragmentation sensor can automatically open Speed Disk and defragment 
the disk.
Many sensors include a particular Norton Utilities program on their context menus. For example, you can choose 
Open Image from the context menu of the Disk Image sensor. If you choose Open System Information from the 
context menu of a memory-related sensor, System Information opens directly to the Memory tab. Drive-related 
sensors open System Information to the Drive tab.
In addition, the Norton System Doctor menu bar and all sensors' context menus include a Utilities item from which 
you can start other Norton Utilities programs.
Click here 
{button ,AL("SYSDOC32_I0430;SYSDOC32_T0150;SYSDOC32_T0160;SYSDOC32_T0170;SYSDOC32_T0180;SYSDOC3
2_T0190;SYSDOC32_T0200;SYSDOC32_T0210;SYSDOC32_T0220;SYSDOC32_T0230")} for related information.



When to hide a sensor
You may not need to know about the current reading of a particular sensor unless it reaches the level you've 
defined as the alarm level. Or you may be interested only in the long-term statistics about the readings for a 
particular sensor. These are two cases where you would want to hide a sensor.
Hiding a sensor simply prevents it from appearing in the Norton System Doctor window. A hidden sensor continues 
to run, maintains the measurement information available in the history window, and can still alert you to an alarm 
condition.

If you have an alarm set for a hidden sensor, be sure you don't set the alarm's properties to "No Action," or
you won't know when the alarm condition occurs.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_T0080;SYSDOC32_T0440")} for related information.



When to reset a sensor
Most sensors maintain history information about their readings from one Windows session to the next. The highest 
and lowest readings recorded appear in a sensor's history window.
You can reset a sensor's highest and lowest readings to zero at any time by clicking the sensor's Reset command. 
For example, if you want to monitor CPU usage while a particular application is running, you can set up the CPU 
Utilization sensor, use its Reset command, and then open the application of interest.

By keeping a second instance of the same sensor active and not resetting it, you can simultaneously 
monitor the cumulative highest and lowest readings as well.
(Sensors that have no history information to maintain such as Current Date and Time and Rescue Readiness

have no Reset command.)
You can reset sensor properties to the defaults by clicking Default on the sensor Properties dialog box tabs.

Click here {button ,AL("SYSDOC32_I0360;SYSDOC32_T0250;SYSDOC32_I0400")} for related information.



When to reset Norton System Doctor
You can reset all Norton System Doctor settings to their defaults at any time. Doing so causes only the default 
sensors to be active, gives those sensors their default properties, resets their history information to zero, and 
returns the Norton System Doctor window to its default appearance. Using this global reset feature is convenient if 
you want to return Norton System Doctor to a known state quickly.
By default, the following sensors are active:

CPU Utilization
alarm off.

Disk Space
alarm displays a recommendation message if free space falls below 5%.

Disk Fragmentation
alarm displays a recommendation message if fragmentation reaches 95%.

Internet Speedometer
alarm off.

Disk Integrity
alarm displays a recommendation message if a disk error is detected.

System Memory
alarm displays a recommendation message if memory information is more than one day old.

Disk Image Information
alarm opens Image when the image information is more than one day old.

Rescue Readiness
alarm off.

Norton Utilities LiveUpdate
alarm off.

Virus Definitions
alarm displays a recommendation message if virus definitions become more than 35 days old.

Virus Scan
 alarm displays a recommendation message if a virus is found on your system.

Click here {button ,AL("SYSDOC32_I0360;SYSDOC32_T0260;SYSDOC32_T0270;SYSDOC32_I0390")} for related 
information.



When to update a sensor
The Update command causes the sensor to update its reading immediately, rather than waiting the normal amount 
of time between updates. For example, if you are concerned that a particular disk may have developed a problem 
and the Disk Integrity sensor is supposed to perform a disk scan every five minutes, you can choose Update from 
the Disk Integrity sensor's context menu to perform the scan now.
Click here {button ,AL("SYSDOC32_T0450;SYSDOC32_T0390;SYSDOC32_T0400")} for related information.



Notes on customizing Norton System Doctor
While Norton System Doctor can do its work with little or no attention from you, it also gives you the option of 
customizing its appearance and behavior.
For example, you can minimize Norton System Doctor while it monitors your computer in the background. When 
minimized, Norton System Doctor appears as a stop light icon in the notification area of the taskbar. Norton System 
Doctor will still notify you or fix problems automatically as they are detected. For example, if Image has not recently
recorded information about a disk's file structure (important information for recovering files), Norton System Doctor 
can automatically open Image for you. Or if your disk develops problems, Norton System Doctor alerts you and 
offers to open Norton Disk Doctor for you.
You can also customize Norton System Doctor configuration in any of these ways:

Hide or unhide the title bar and Symantec logo bar from the View menu. When the title bar is hidden, you 
can move Norton System Doctor by clicking anywhere in its window and dragging to the position you want.

Choose or create a display scheme that specifies dimensions, colors, and bitmap backgrounds for the 
sensors.

The background bitmap feature is enabled only if your display is set to support more than 256 colors.
Hide or unhide active sensors. When hidden, a sensor continues to monitor its corresponding condition, 

and will still warn you or take appropriate action when its alarm is triggered. To hide a sensor, click Properties from 
the sensor's context menu and check the Hidden checkbox on the Style tab. To unhide any hidden sensors, click 
Hidden Sensors from the Norton System Doctor View menu.

Add or remove sensors. Use the Norton System Doctor Sensor menu or any sensor's context menu.
Change the sensors' positions. Simply drag any sensor to the position where you want it to appear. (If the 

title bar is hidden, hold down the Ctrl key while dragging the sensor to its new position.)
Dock the Norton System Doctor window. When you select Dock from the View menu, Norton System Doctor

will remain against one of the four edges of your display
simply drag it to the edge of the screen you want it to use. Clicking Auto Hide further clears your desktop by 

reducing the Norton System Doctor window to a thin gray line. When you place the mouse pointer on this line, 
Norton System Doctor expands to show you all sensors; move the cursor away, and the window is hidden again 
automatically.

You cannot set both Norton System Doctor and the Windows taskbar to auto hide along the same edge of 
your display.
You can save your custom Norton System Doctor configuration for future use, and can even create different sensor 
configurations for different monitoring tasks.
Click here 
{button ,AL("SYSDOC32_T0010;SYSDOC32_T0030;SYSDOC32_T0090;SYSDOC32_T0100;SYSDOC32_T0110;SYSDOC3
2_T0240;SYSDOC32_T0340;SYSDOC32_T0380;SYSDOC32_T0390;SYSDOC32_T0400;SYSDOC32_T0410;SYSDOC32_T
0440;SYSDOC32_I0440;SYSDOC32_T0500;SYSDOC32_T0510;SYSDOC32_T0530;SYSDOC32_T0095")} for related 
information.



About sensor alarms
Most sensors include an alarm that you can set to be triggered when the condition being monitored reaches a 
critical value. When triggered, the alarm can alert you to the condition by displaying a message that suggests 
corrective action, or by playing a sound file you specify. If the sensor is visible, its display can also change color 
when the alarm condition occurs.
Several of the sensors can take corrective action when conditions trigger an alarm. For example:

If an error condition has been detected on a disk, Norton Disk Doctor can be run automatically to correct 
the problem.

When system recovery information has not been updated recently, Image and Rescue can be run 
automatically to refresh the information.

When disk space is running low, Norton Space Wizard can be run automatically to help you free up disk 
space by removing unnecessary or duplicate files.
The Norton System Doctor alarm feature can also help you fine-tune the performance of your computer. For 
example, you can set alarms to notify you when your disk becomes highly fragmented, when your system's disk 
cache performance falls below a certain level, and when your physical memory (RAM) usage reaches a certain level.

To determine an appropriate alarm setting for a sensor, be sure to consider current usage of the resource 
the sensor measures. Otherwise, the alarm will either get triggered too frequently or not frequently enough.
You can define an alarm for every Norton System Doctor sensor except for Current Date and Time, Windows Up 
Time, and Windows Performance Stats.

If you want to set an alarm for a sensor but otherwise don't need to know about the sensor's current 
reading, you can hide the sensor.
Click here {button ,AL("SYSDOC32_T0040;SYSDOC32_T0070;SYSDOC32_T0080;SYSDOC32_I0380")} for related 
information.



About sensor maximum readings
Most sensors have an absolute maximum reading, which is the highest measurement possible for a particular 
sensor. For example, the absolute maximum reading for the Physical Memory sensor is the amount of RAM installed 
in the computer, and the absolute maximum reading for the Disk Space sensor is the total amount of space on the 
disk. Norton System Doctor uses the absolute maximum reading when displaying information in a sensor's history 
window.
By contrast, these Norton System Doctor sensors have no absolute maximum readings:

Cache Throughput
Network Reads Throughput
Network Writes Throughput
Open Files
Threads

For example, the Threads sensor shows the number of threads running. The upper limit on the number that could 
be running depends upon many factors relating to the capabilities and configurations of individual computers.
If a sensor does not have an absolute maximum reading, you can let Norton System Doctor use the highest reading 
as the maximum, or you can specify your own maximum as one of the sensor's properties. For example, you could 
set the maximum reading for the Threads sensor at 30. If the Threads sensor reports a 50% usage of threads, you 
would know that 15 threads are in use.
Click here {button ,AL("SYSDOC32_T0250;SYSDOC32_T0320")} for related information.



Notes for network administrators
Norton System Doctor includes a number of sensors that can help you monitor the performance and usage of your 
network:

The Disk Space sensor monitors the space either free or available on network drives (as well as on local 
hard drives).

The Open Files sensor monitors the number of files that are open on network drives (as well as on local 
hard drives).

The Network Reads Throughput sensor measures the speed at which a particular computer reads data 
from a network drive through its network card.

The Network Writes Throughput sensor measures the speed at which a particular computer writes data to 
a network drive.

The Windows Performance Stats sensors provide information that is specific to your type of network. 
Examples of categories of network information available (if they are applicable to your network) are IPX/SPX 
Compatible Protocol, Microsoft Network Server, NCP Redirector, and SMB Redirector.
Other Norton System Doctor sensors can also be helpful in troubleshooting network problems. For example, if you're
trying to determine why network performance on one computer is slower than on other comparable ones, many of 
the sensors can help you compare processing loads and capabilities.

To obtain detailed network information, use System Information.
Click here 
{button ,AL("SYSDOC32_I0190;SYSDOC32_I0240;SYSDOC32_I0250;SYSDOC32_I0260;SYSDOC32_I0280")} for 
related information.



Command-line options
You can run Norton System Doctor from the command line by choosing Run from the Start menu. Use the following 
syntax:

SYSDOC32 /RESET
/RESET Resets Norton System Doctor using the default sensors with their default properties.



To add a sensor:
1 Click the Sensor menu of the Norton System Doctor window or click Add Sensor on any sensor's context menu.
2 Select the sensor you want to add from the cascading menus.

If you are adding a Windows Performance Stats sensor, select the category and item that defines the 
statistics you want to monitor.
Click here 
{button ,AL("SYSDOC32_I0350;SYSDOC32_T0020;SYSDOC32_T0050;SYSDOC32_T0140;SYSDOC32_T0240;SYSDOC3
2_I0050")} for related information.



To set a sensor's properties:
1 Double-click the sensor.
2 Click the tab for the properties you want to set.

You can also choose Properties from the sensor's context menu or from the Edit menu of the Norton 
System Doctor window.
Click here 
{button ,AL("SYSDOC32_I0350;SYSDOC32_T0010;SYSDOC32_T0050;SYSDOC32_T0140;SYSDOC32_T0240;SYSDOC3
2_T0260;SYSDOC32_I0050")} for related information.



To arrange sensors within the Norton System Doctor window:
Drag the sensor to a new position in the Norton System Doctor window. (If Norton System Doctor is docked

or if the title bar is not displayed, you must hold the Control key while you drag the sensor.)
To "drag" a sensor, press the mouse button while the mouse cursor is on the sensor, then move the mouse 

while holding the button down.
Click here {button ,AL("SYSDOC32_I0420;SYSDOC32_T0095,SYSDOC32_T0090;SYSDOC32_T0060")} for related 
information.



To disable a sensor's alarm:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Click the Alarm tab.
3 Clear the Enabled check box in the Alarm Settings group.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_T0070;SYSDOC32_T0290")} for related information.



To display a sensor's history:
Click History Window on the sensor's context menu or from the Edit menu of the Norton System Doctor 

window.
History information is not available for all sensors.

Click here {button ,AL("SYSDOC32_I0360;SYSDOC32_T0250")} for related information.



To display the Norton System Doctor title and menu bars:
Check Show Title Bar and Show Symantec Logo on the View menu of Norton System Doctor or on the View 

menu of any sensor's context menu. Clicking these menu items alternately checks and unchecks them.
You can also double-click areas in the Norton System Doctor window that are not occupied by sensors. Double-
clicking toggles the title and menu bars on and off.

You cannot display the title and menu bars when Norton System Doctor is docked.
Click here {button ,AL("SYSDOC32_I0420;SYSDOC32_T0090;SYSDOC32_T0095")} for related information.



To enable a sensor's alarm:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Click the Alarm tab.
3 Check Enabled in the Alarm Settings group.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_T0040;SYSDOC32_T0290")} for related information.



To hide a sensor:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Check Hidden in the Sensor Size group.
Click here {button ,AL("SYSDOC32_T0090;SYSDOC32_T0100;SYSDOC32_T0440;SYSDOC32_I0380")} for related 
information.



To hide the Norton System Doctor title and menu bars:
Uncheck Show Title Bar and Show Symantec Logo on the View menu of Norton System Doctor or on the 

View menu of any sensor's context menu.
You can also double-click areas in the Norton System Doctor window that are not occupied by sensors. Double-
clicking toggles the title and menu bars on and off.

You cannot display the title and menu bars when Norton System Doctor is docked.
Click here 
{button ,AL("SYSDOC32_I0420;SYSDOC32_T0080;SYSDOC32_T0100;SYSDOC32_T0095;SYSDOC32_T0090")} for 
related information.



To dock Norton System Doctor:
Check Dock on the View menu.

You can regain additional desktop space if you choose to auto-hide the Norton System Doctor window while it is 
docked.
To undock Norton System Doctor:
1 Right-click anywhere in the Norton System Doctor window.
2 Choose View from the context menu.
3 Uncheck Dock.
Click here {button ,AL("SYSDOC32_I0420;SYSDOC32_T0080;SYSDOC32_T0090;SYSDOC32_T0100")} for related 
information.



To hide the Norton System Doctor window:
Check Auto Hide on the View menu.
Norton System Doctor must be docked in order to use the auto hide feature. Norton System Doctor and the

Windows taskbar cannot both be set to auto hide along the same edge of the screen.
Click here {button ,AL("SYSDOC32_I0420;SYSDOC32_T0080;SYSDOC32_T0090;SYSDOC32_T0095")} for related 
information.



To keep Norton System Doctor on top of other windows:
Check Always On Top on the View menu of Norton System Doctor or on the View menu of any sensor's 

context menu.
Click here {button ,AL("SYSDOC32_I0420;SYSDOC32_T0420;SYSDOC32_T0430")} for related information.



To monitor Windows performance statistics:
1 Click the Sensor menu of the Norton System Doctor window.
2 Move the mouse over Performance.
2 Choose Windows Performance Stats from the cascading menu.
3 Select the category and item of information you want to monitor.

Add a separate sensor for each type of performance information you want to monitor.
Click here {button ,AL("SYSDOC32_I0280")} for related information.



To open Norton Utilities programs from Norton System Doctor:
1 Click the Utilities menu of Norton System Doctor.
2 Move the mouse over the category of program you want to start.
3 Click the name of the program you want to open.
Click here {button ,AL("SYSDOC32_I0370")} for related information.



To remove a sensor:
1 Click the sensor.
2 Click Remove on the sensor's context menu or from the Edit menu of the Norton System Doctor window.
Click here {button ,AL("SYSDOC32_T0010;SYSDOC32_T0080;SYSDOC32_T0440")} for related information.



To reset a sensor's history readings:
Click Reset on the sensor's context menu or from the Edit menu of the Norton System Doctor window.

Click here 
{button ,AL("SYSDOC32_I0360;SYSDOC32_T0270;SYSDOC32_T0260;SYSDOC32_I0390;SYSDOC32_I0400;SYSDOC32
_I0410")} for related information.



To reset a sensor's properties to the defaults:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Click the tab for the properties you want to reset.
3 Click the Default button.
Click here 
{button ,AL("SYSDOC32_I0360;SYSDOC32_T0250;SYSDOC32_T0270;SYSDOC32_I0390;SYSDOC32_I0400")} for 
related information.



To reset Norton System Doctor to the default sensors:
1 Choose Options from the View menu.
2 Click the Active Sensors tab.
3 Click Default.
Click here 
{button ,AL("SYSDOC32_I0360;SYSDOC32_T0250;SYSDOC32_T0260;SYSDOC32_T0280;SYSDOC32_I0390;SYSDOC32
_I0400")} for related information.



To set a sensor's alarm properties:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Click the Alarm tab.
3 Set the alarm properties you want.

To activate the alarm, make sure Enabled is checked. Also make sure the alarm level you select is 
reasonable, so the alarm won't be triggered too frequently or too infrequently. Click Default on the Alarm tab to 
reset the sensor's alarm to the default settings.
Click here {button ,AL("SYSDOC32_I0430;SYSDOC32_T0040;SYSDOC32_T0070")} for related information.



To set the drive to be monitored:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Click the Drive tab.
3 Click the drive you want to monitor in the Drive to Monitor list.
4 For the Disk Fragmentation, Disk Integrity, Disk Surface Test sensor, and Virus Scan sensors use the slide bars to

set the drive-scanning properties.
To monitor more than one drive with a particular sensor type, add a separate sensor for each drive. The 

Drive tab is not available for all sensors.
Click here 
{button ,AL("SYSDOC32_I0160;SYSDOC32_I0170;SYSDOC32_I0180;SYSDOC32_I0190;SYSDOC32_I0200;SYSDOC32_I
0260")} for related information.



To set a sensor's graph type:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 From the Type drop-down list, click the type of graph you want displayed.

Not all sensors can display information in a graph format.
Click here 
{button ,AL("SYSDOC32_I0050;SYSDOC32_T0120;SYSDOC32_T0130;SYSDOC32_T0340;SYSDOC32_T0350;SYSDOC3
2_T0370")} for related information.



To set a sensor's maximum reading:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Click the Measurement tab.
3 Type the maximum value you want in the box labeled Maximum in the Sensor Maximum Reading group.

You cannot change the maximum reading for all sensors.
Click here {button ,AL("SYSDOC32_I0440;SYSDOC32_T0330;SYSDOC32_T0360")} for related information.



To set a sensor's measurement method:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Click the Measurement tab.
3 Click the option you want in the Measurement Type group.

Only sensors displaying information in graph format include this property.
Click here {button ,AL("SYSDOC32_T0320;SYSDOC32_T0360")} for related information.



To set the base height and width used for all sensors:
1 Choose Options from the View menu.
2 Use the slide bars to adjust the sample sensor's height and width.

The dimensions you set will be used for all small sensors. Large sensors will be the same height and twice 
the width of the small sensors.
To set a sensor to display as large or small size:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Click the Large or Small in the Sensor Size group box.
Click here 
{button ,AL("SYSDOC32_T0120;SYSDOC32_T0130;SYSDOC32_T0310;SYSDOC32_T0350;SYSDOC32_T0370;SYSDOC3
2_T0410;SYSDOC32_T0520;SYSDOC32_T0530")} for related information.



To set a sensor's unit of measurement:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Select the units of measure you want from the Sensor Scale group.

You cannot change the unit of measurement for some sensors, either because they do not display 
information in graph format or because they have only one unit type available.
Click here 
{button ,AL("SYSDOC32_T0120;SYSDOC32_T0130;SYSDOC32_T0310;SYSDOC32_T0340;SYSDOC32_T0370")} for 
related information.



To set a sensor's update interval:
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Click the Measurement tab.
3 Drag the Time Between Sensor Readings slide bar to the interval setting you want.

Every sensor reading consumes a small portion of system resources. If the time between sensor readings is
set too short, the sensor will use more system resources while not necessarily providing much new information. If 
the time between readings is set too long, there may be a delay before a problem is detected. It is usually best to 
use the default setting for this option.
Click here {button ,AL("SYSDOC32_T0320;SYSDOC32_T0330")} for related information.



To set sensor colors:
1 Click Options on the Norton System Doctor View menu.
2 From the Item list box, click the sensor component whose color you want to change.
3 Click Color to specify a new color.
Click here 
{button ,AL("SYSDOC32_I0420;SYSDOC32_T0030;SYSDOC32_T0090;SYSDOC32_T0100;SYSDOC32_T0110;SYSDOC3
2_T0370;SYSDOC32_T0380;SYSDOC32_T0420;SYSDOC32_T0430;SYSDOC32_T0520;SYSDOC32_T0530")} for related
information.



To set sensor fonts:
1 Click Options on the Norton System Doctor View menu.
2 From the Item list box, click Text or Calendar Text.
3 Click Font.
4 Select the desired font, font style, and font size.
Click here {button ,AL("SYSDOC32_T0420;SYSDOC32_T0410;SYSDOC32_T0520;SYSDOC32_T0530")} for related 
information.



To start Norton System Doctor minimized:
1 Click Options in the Norton System Doctor View menu.
2 Click the Window Settings tab.
3 Check Start Minimized in the Startup Options group.

Norton System Doctor will automatically minimize itself the next time it is started.
Click here 
{button ,AL("SYSDOC32_T0030;SYSDOC32_T0090;SYSDOC32_T0100;SYSDOC32_T0110;SYSDOC32_T0380;SYSDOC3
2_T0390;SYSDOC32_T0430")} for related information.



To start Norton System Doctor automatically with Windows:
1 Click Options in the Norton System Doctor View menu.
2 Click the Window Settings tab.
3 Check Start Automatically With Windows in the Startup Options group.
Click here 
{button ,AL("SYSDOC32_T0030;SYSDOC32_T0090;SYSDOC32_T0100;SYSDOC32_T0110;SYSDOC32_T0380;SYSDOC3
2_T0390;SYSDOC32_T0420")} for related information.



To show all hidden sensors:
Check Hidden Sensors on the View menu of Norton System Doctor or on the View menu of any sensor's 

context menu.
Clicking this menu item alternately checks and unchecks it, toggling the display of hidden sensors.

Click here {button ,AL("SYSDOC32_T0080;SYSDOC32_I0380;SYSDOC32_T0445")} for related information.



To unhide a single sensor
1 Double-click the sensor, or choose Properties from the sensor's context menu.
2 Clear the Hidden check box in the Sensor Size group.
Click here {button ,AL("SYSDOC32_T0080;SYSDOC32_I0380;SYSDOC32_T0440")} for related information.



To update a sensor's reading:
Choose Update from the sensor's context menu or from the Edit menu of the Norton System Doctor 

window.
Click here {button ,AL("SYSDOC32_I0390;SYSDOC32_I0410")} for related information.



The shortcut button could not open Norton System Doctor.
To open Norton System Doctor:
1 Click Start on the Windows taskbar.
2 Click Programs.
3 Click Norton Utilities.
4 Click Norton System Doctor.



The shortcut button could not open the System Doctor Options dialog box.
To open the System Doctor Options dialog box:
1 Click Start on the Windows taskbar.
2 Click Programs.
3 Click Norton Utilities.
4 Click Norton System Doctor.
5 Choose Options from the View menu of any sensor's context menu or from the Norton System Doctor View 

menu.



To save a custom Norton System Doctor configuration:
1 Click File on the Norton System Doctor menu bar.
2 Click Save Configuration As to save the current configuration with it's own identifying name.
Your configuration will be written to file with an NSD extension. The configuration will become the new default 
configuration used when you open Norton System Doctor.

The name of the current configuration appears in the Norton System Doctor window title bar. If you change
the configuration and wish to save the changes with the same name, click Save Configuration on the File menu.
Click here {button ,AL("SYSDOC32_T0510;SYSDOC32_T0520;SYSDOC32_T0530;SYSDOC32_I0420")} for related 
information.



To open a custom Norton System Doctor configuration:
1 Click File on the Norton System Doctor menu bar.
2 Click Open Configuration.
3 If necessary, use the Directory list box to choose the directory in which the configuration (.NSD) file is located.
4 Select the configuration file you want to open.

The name of the current configuration appears in the Norton System Doctor window title bar. If you change
the configuration and wish to save the changes with the same name, click Save Configuration on the File menu.
Click here {button ,AL("SYSDOC32_T0500;SYSDOC32_T0520;SYSDOC32_T0530;SYSDOC32_I0420")} for related 
information.



To create a Norton System Doctor display scheme:
1 Click Options on the Norton System Doctor View menu.
2 Choose the sensor dimension, color, font, and bitmap background options you want.
3 Click Save As, and give your scheme a name.
You can use this tab to switch Norton System Doctor to your display scheme at any time. A display scheme stores a 
set of sensor dimensions, colors, fonts, and background bitmaps. A Norton System Doctor custom configuration 
stores only the sensor layout in the Norton System Doctor window.

The background bitmap feature is enabled only if your display is set to support more than 256 colors.
Click here {button ,AL("SYSDOC32_T0500;SYSDOC32_T0510;SYSDOC32_T0530;SYSDOC32_I0420")} for related 
information.



To use a Norton System Doctor display scheme:
1 Click Options on the Norton System Doctor View menu.
2 Click a display scheme from the Scheme drop-down list box.
Click here {button ,AL("SYSDOC32_T0500;SYSDOC32_T0510;SYSDOC32_T0520;SYSDOC32_I0420")} for related 
information.



To specify files to be scanned for viruses:
1 Right-click the Virus Scan sensor.
2 Choose Properties from the context menu.
3 Click the Files To Scan tab.
To add a new file type to be scanned:
1 Click Add.
2 Type the file extension for the new file type.
To remove a file type from virus scanning:
1 Click the extension for the file type in the list.
2 Click Remove.



Shows how quickly data is retrieved from the disk. This sensor takes into account both data read from the disk cache (a part of 
memory set aside to temporarily store data from your disk) and data that must be read directly from the disk. Can be used to assess
the effectiveness of the disk cache in speeding up data access.



Shows the amount of free disk space on a local or network drive the disk space that is not in use by data files or by the Windows 
swap file.



Shows the number of threads (subprocesses) currently running on the computer.



This sensor monitors the portion of physical memory (RAM) that is not used by the cache.



Shows how much of the physical memory (RAM) is free. Physical memory includes a variable-size cache, which generally uses 
most of the free memory. Therefore, most of the physical memory is always in use. The cache size is automatically reduced as 
physical memory is needed for other purposes.



Shows the amount of available disk space currently unused for temporary data storage. This unused space includes space reserved
for the Windows swap file but still unused for data storage (swap file slack space).



Shows the amount of free disk space currently reserved for use by the Windows swap file. By default, Windows dynamically 
enlarges and reduces the swap file according to the demands of the system.



Shows how much of the space reserved for the Windows swap file is currently in use for temporary data storage.



Shows the time the CPU spends executing instructions relative to the time it is idle.



Shows how much of the data your computer needs is found in the disk cache. If data is not found in the cache, it must be read 
directly from the disk, which is a slower process.



Shows the speed at which your computer reads data from a Novell NetWare network.



Shows the speed at which your computer writes data to a Novell NetWare network.



Shows various performance statistics provided by Windows. These sensors monitor the same types of information reported by the 
Windows System Monitor program. You can add multiple sensors to monitor different types of performance data. Some of this 
information duplicates native System Doctor sensors. However, Windows Performance Stats sensors do not include alarms.



Shows how much of the disk cache is currently in use.



Shows the number of files that are currently open on a local hard drive or network drive to which you have access.



Shows how much of the memory resources allocated to the Windows Graphics Device Interface (GDI) are available.



Shows the amount of User memory resources currently free. Part of the User memory must be allocated from a fixed-size area of 
memory, and this sensor measures the portion of that area that is free.



Shows the number of 16-bit selectors currently available. 16-bit Windows applications require 16-bit selectors for memory 
management.



Shows how much of the conventional memory (the lower 640K of RAM) is free.



Shows the battery charge remaining (for portable computers that use batteries).



Shows you how much time has elapsed since Windows was last started.



Shows the current date and time.



Shows how much of the data on a disk is unfragmented.



Shows the integrity of a disk's file allocation table, folders, and compressed disk structures (if any). A red light means significant 
problems exist, a yellow light means only lost clusters are detected, and a green light means no system problems have been 
detected.



Shows how recently the disk was imaged. A green light means Image has run within the time period specified on the Alarm tab of 
the Properties dialog box. A yellow light means it's within 10 percent of time to run Image, and a red light means it's time to run 
Image. The large sensor style shows the date and time that Image was last run.



Shows how recently Rescue Disk was run. Use this sensor to ensure that your rescue disk is current. A green light means Rescue 
Disk has run within the time period specified on the Alarm tab of the Properties dialog box. A yellow light means it's within 10 percent
of time to run Rescue Disk, and a red light means it's time to run Rescue Disk again. The large sensor style shows the date and time
that Rescue Disk was last run.



Shows the progress of the surface test, which scans a disk's surface for errors.



Shows when the virus definitions files were last updated. Keeping your virus definitions files up to date guarantees that the Virus 
Scan sensor can identify the latest viruses that have been described.
If you are connected to the Internet, this sensor can use LiveUpdate to get new virus definitions automatically when they become 
available. Updated virus definitions files are made available monthly from Symantec Corporation, and can also be downloaded from 
many computer bulletin boards, electronically transferred from Symantec's FTP or World Wide Web sites, or mailed to you directly 
from Symantec Corporation.

A red stoplight does not mean your system is infected with a virus; it means your virus definitions files are getting old and 
that there is probably a new set of definitions available from Symantec corporation. This sensor will only turn green when the virus 
definitions on your machine are younger than the age set on the Alarm tab.



Periodically scans your system for viruses. Use the Drive tab on this sensor's properties to specify how often the system should be 
scanned. The stoplight turns red if viruses are found. If you have installed Norton AntiVirus, it will be automatically launched to 
remove any viruses that are found.



Shows when a drive failure is imminent.
Self-Monitoring And Reporting Technology (SMART) is built into newer hard drives. It allows these drives to monitor their operation 
and predict most hardware failures before they occur. With this warning, you can back up your files and replace or repair your drive 
before losing valuable data. This sensor only supports drives that have SMART built-in.



Shows the amount of slack space on a disk.
The operating system allocates (reserves) space for files in discrete chunks. Most files, however, occupy less physical space on the 
disk than the operating system has reserved. Slack space is the excess space allocated for a file that remains unoccupied by any of 
that file's data. Once allocated for a particular file, disk space cannot be used for any other purpose, so slack space is essentially 
disk space that is wasted. Using a smaller cluster size, as you can do with the FAT32 file system, helps minimize slack space.



Shows when system memory resources are strained. When this sensor turns yellow or red, you should close some applications.



Shows the number of files currently stored in the Norton Protected Recycle Bin.



Shows when you should check for updates to Norton Utilities.



Shows the speed of Internet packet transmission between your computer and a site of your choice.



Shows the speed of your Internet connection to the host site of your choice.



Reminds you to check HealthyPC.com regularly for new computer tips, advice, and free software samples.
Members of the HealthyPC.com Health Club can take advantage of VitalCheck and LiveUpdate. VitalCheck complements 

the data protection afforded by Norton Utilities by providing virus repair. LiveUpdate lets you update other software as easily as 
Norton System Doctor updates your Norton Utilities and virus definitions files.



Connects to HealthyPC.com using your computer's default web browser. The default web browser is the one that starts 
automatically when you double-click on a file with file extension .HTM.

This button is disabled if no default browser is defined for your system.



Shows the current dimensions and colors used for the sensor displays. The sample graphic represents the small-style sensor. The 
large-style sensors are always twice the width of the small-style sensors.



Use this slide bar to set the height of the sensors.



Use this slider to set the width of the sensors. The dimensions you set apply to small-style sensors; Norton System Doctor 
automatically sets the width of large-style sensors to twice this width.



Lists the available sensor schemes. A scheme defines the sensor dimensions, colors, text fonts, and background bitmap use by the 
Norton System Doctor window. You can use one of the listed schemes or define your own and add it to the list.

The background bitmap feature is enabled only if your display is set to support more than 256 colors.



Saves the currently set sensor dimensions, colors, text fonts, and background bitmap as a Norton System Doctor scheme with a 
name you specify. After it is saved, the scheme will appear in the drop-down list. You can switch Norton System Doctor to this 
sensor appearance scheme at any time.

The background bitmap feature is enabled only if your display is set to support more than 256 colors.



Deletes the selected scheme.



Lets you specify the color assigned to the sensor element that is selected in the Item drop-down list box.



Lists the individual elements that make up a sensor. You can control the color of each of these elements.



Lets you specify the font properties of the text displayed on the sensors. This button is available only when Text or Calendar Text is 
selected in the list box.



Lets you type the pathname of a bitmap graphic    file to be used as the background image of the sensors. You may also use the 
button to the right of the text box to browse your system for a bitmap file.

The background bitmap feature is enabled only if your display is set to support more than 256 colors.



Lets you browse your system for a bitmap to use for the background image on the Norton System Doctor sensors.

The background bitmap feature is enabled only if your display is set to support more than 256 colors.



Resets all Norton System Doctor sensor appearance properties to their default settings.



Lists the currently active sensors in the order they appear in the Norton System Doctor window.



Moves the sensor selected in the Sensor Order list box up one position. The Norton System Doctor window reflects the order of the 
sensors as they appear in the Sensor Order list.



Moves the sensor selected in the Sensor Order list box down one position. The Norton System Doctor window reflects the order of 
the sensors as they appear in the Sensor Order list.



Keeps the Norton System Doctor window on top of any other windows on your desktop.



Controls whether top title and menu bars are include in the Norton System Doctor window. When the title and menu bars are hidden,
you can restore them by right-clicking any sensor and choosing    Show Title Bar from the View menu.

Double-clicking any sensor-free portion of the Norton System Doctor window toggles the display of title and menu bars.



Controls whether the Symantec logo bar is displayed on the side of the Norton System Doctor window.



Hides the Norton System Doctor window by reducing it to a thin gray line along one edge of the screen. Moving the mouse cursor 
against the line redisplays the full Norton System Doctor window.

Norton System Doctor must be docked in order to use the auto hide feature. Norton System Doctor and the Windows 
taskbar cannot both be set to auto hide along the same edge of the screen.



The Auto Hide feature is available only when Norton System Doctor is docked.
Norton System Doctor and the Windows taskbar cannot both be set to auto hide along the same edge of the screen.



Docks the Norton System Doctor window, snapping it to the edge of the display. You can drag the docked window to any of the four 
edges of the display. Though the menu bar is hidden, you can access all menu options by right-clicking to display a context menu. 
You can move the sensors within the docked window by holding down the Ctrl key and dragging sensors to new positions.



Automatically starts Norton System Doctor whenever you start Windows.



Causes Norton System Doctor to open minimized, so it appears only as an icon in the Windows taskbar. To restore the full Norton 
System Doctor window, click the icon.



Resets all Norton System Doctor window settings to their defaults.



Lists all Norton System Doctor sensors. Select the sensors you want to add to the Norton System Doctor window, then click Add.



Lists the Norton System Doctor sensors that are currently active.



Adds the sensors currently selected in the Available Sensors list box to the Current Sensors list box. These sensors are added to 
the Norton System Doctor window and begin monitoring your system when you click OK or Apply.
(This command button is not enabled until you have selected one or more sensors in the Available Sensors list box.)



Lets you set the properties for the sensor selected in the Current Sensors list box.
(This command button is not enabled until you have selected a sensor in the Current Sensors list box.)



Removes the selected sensors from the Current Sensors list box. These sensors are deactivated and removed from the Norton 
System Doctor window when you click OK or Apply. The sensors are not removed from the Available Sensors list, so they can be 
added back to the Norton System Doctor window at any time.
(This command button is not enabled until you have selected a sensor in the Current Sensors list box.)



Configures Norton System Doctor to have only the default sensors active.



Displays how the sensor looks with the currently selected style properties.



Resets this sensor's style properties to their default settings.



Lists the different visual formats available for this sensor. Sensors that display information in graph formats can appear as:
Bar graphs
Analog gauges similar to automobile "gas gauges"
Histograms that display multiple readings collected over a period of time
Digital readouts

This list is disabled for sensors that do not display information as graph sensors.



Displays the sensor in a large-style format.



Displays the sensor in a small-size format.



Hides the sensor so it doesn't appear in the Norton System Doctor window. Although the sensor is hidden, it is still active and will 
still monitor its assigned condition and trigger its alarm, if the alarm is enabled.



Causes the sensor to display how much of the resource being monitored is available. The sensor label changes to reflect what the 
sensor is displaying. This option button is not available if it is not meaningful for this sensor.



Causes the sensor to display how much of the resource being monitored is in use. The sensor label changes to reflect what the 
sensor is displaying. This option button is not available if it is not meaningful for this sensor.



Causes the sensor to display how much of the data on the drive being monitored is fragmented. Fragmented data is not stored in 
contiguous (side-by-side) data clusters, so it takes longer to access and manipulate.



Causes the sensor to display how much of the data on the drive being monitored is unfragmented. Unfragmented data is stored to 
contiguous (side-by-side) data clusters and can be accessed and manipulated faster than fragmented data.



Clicking the down arrow  displays a list of the units of measurement available for this sensor. Click the units you want to use in the 
list; the sample graphic reflects the units you select. This drop-down list box is not available if there are no measurement options for 
this sensor.



Resets all style properties for this sensor to their default settings.



Enables the alarm for this sensor. The alarm action occurs when the alarm trigger condition is met.



Sets the trigger level the level at which the alarm action is to occur. As you adjust the slide bar, the number corresponding to its 
position appears in the text box.



Lets you set the trigger level the level at which the alarm action is to occur.



Clicking the down arrow  displays a list of the units of measurement available for this sensor's trigger. Click the units you want to 
use. This drop-down list box is not available if there are no measurement options for this sensor.



Displays how the sensor looks with and without the trigger level indicator. (This indicator is controlled through the Show Trigger 
Level check box).



Determines whether an indication of the trigger level is shown on the sensor graphic. The sample graphic shows this indicator when 
this check box is checked. When the monitored condition reaches or exceeds the trigger level, the graph changes from displaying its
normal color to its warning color, and the alarm action is executed.



Causes the sensor to do nothing but change from its normal color to its warning color when the alarm trigger condition occurs.



Causes the sensor to recommend corrective measures you can take when the alarm trigger condition occurs.



Lets you specify how frequently the alarm action is to be repeated until the alarm condition is remedied.



Causes Norton System Doctor to automatically take corrective action when certain sensor's alarms are triggered:
Disk Fragmentation sensor runs Speed Disk to defragment the disk.
Disk Image Information sensor runs Image to create a current disk image.
Disk Integrity and Disk Surface Test sensors run Norton Disk Doctor to repair problems.
Rescue Readiness sensor runs Rescue Disk to create a current rescue disk.
Virus Scan sensor runs Norton AntiVirus, if it is installed on your computer.

This option is not available for other sensors



Lets you specify when necessary repairs should be made.



Lets you specify options for certain automatic repairs. This button is enabled only for some of the sensors that provide automatic 
repairs.



Causes the sensor to play the specified WAVE or MIDI format sound file when the alarm condition occurs.



Lets you enter the name of a WAVE (*.WAV) or MIDI (*.MID) format sound file to be played when the alarm condition occurs. This 
text box is enabled only if Play Sound is checked.



Lets you browse your drives for the name of a WAVE (*.WAV) or MIDI (*.MID) format sound file.



Plays the WAVE or MIDI sound file specified in the text box.



Lets you specify how old image, rescue, or virus definitions information can become before the alarm is triggered. Specify the 
frequency at which you want the alarm triggered; the alarm can remind you to run Image (for the Disk Image Information sensor) or 
Rescue Disk (for the Rescue Readiness sensor), or can run those programs automatically for you at the specified intervals.



Lists the units of time for the alarm trigger. The options are minutes, hours, days, and weeks.



Prevents the alarm from being triggered if the only problems detected are lost clusters.



Resets all alarm properties for this sensor to their default settings.



Lets you specify how frequently the sensor updates its readings. The text under the slide bar indicates the current setting.



Displays the actual current reading detected by the sensor. This option button is disabled if it has no meaning for this sensor.



Configures the sensor to show an averaged reading, weighted in favor of the most recent readings. This option button is disabled if 
it has no meaning for this sensor.



Lets Norton System Doctor establish the maximum reading for this sensor. Initially, the maximum reading is the number displayed in
the Maximum text box. If the sensor records a reading that is higher than that number, the highest reading becomes the maximum. 
Norton System Doctor displays the maximum reading in the history window and uses it to calculate the percentage of the sensor's 
resource relative to the maximum.
This option button is disabled if the sensor has an absolute upper limit.



Sets the maximum value for the sensor equal to the number displayed in the Maximum text box, regardless of the highest reading 
the sensor actually records. Norton System Doctor displays the maximum reading in the history window and uses it to calculate the 
percentage of the sensor's resource relative to the maximum.
This option button is disabled if the sensor has an absolute upper limit.



Lets you enter an upper limit for this sensor's readings:
If Let System Doctor Control is selected, the number in this text box is the starting maximum. If the sensor records an 

actual reading that is higher than this number, the maximum reading is set equal to the highest reading.
If Use Fixed Maximum is selected, the number in this text box is set as a fixed maximum reading for the sensor, 

regardless of the highest reading the sensor actually records.
Norton System Doctor displays the maximum reading in the history window and uses it to calculate the percentage of the sensor's 
resource that is used or free.
This option button is disabled if the sensor has an absolute upper limit.



Resets all measurement-related sensor properties to their default settings.



Clicking the down arrow  displays a list of the drives that this sensor can monitor. Click the drive you want this sensor to monitor. 
(To monitor more than one drive, set up a separate sensor for each.)



Lets you specify how frequently the sensor is to scan the drive. The text under the slide bar indicates the current setting.
The properties for the Disk Integrity, Disk Fragmentation, and Virus Scan sensors include this slide bar. If you adjust the slide bar 
setting for one of these sensors, the setting is automatically adjusted for the other sensors to match.



Lets you specify how long the sensor is to wait before retrying to scan the drive if that the scan is interrupted (or cannot be 
performed) at the scheduled time because of other system activity. The text under the slide bar indicates the current setting.
The properties for the Disk Integrity, Disk Fragmentation, and Virus Scan sensors include this slide bar. If you adjust the slide bar 
setting for one of these sensors, the setting is automatically adjusted for the other sensors to match.



Lists the categories of performance data that can be monitored. The specific categories available depend on your system 
configuration. At a minimum, the list box includes: File System, Kernel, and Memory Manager.



Lists the type of performance data that can be monitored. When you click OK, a sensor for the selected item is added to the Norton 
System Doctor window.
(You can add multiple sensors to monitor different types of performance data provided by Windows.)



Describes the subkey selected in the Item list box.



Displays the title that appears with this sensor if you use the large sensor style, and lets you enter a different title.



Displays the title that appears with this sensor if you use the small sensor style, and lets you enter a different title.



Resets the Title and Abbreviated Title to their default values for this sensor.



Displays a brief explanation of the alarm condition.



Displays suggestions for correcting the alarm condition.



Closes this message box for a specified period of time, then redisplays the message if the alarm condition still exists. (The period of 
time is one of the sensor properties you can set on the Alarm tab of the sensor's Properties dialog box.)



Closes this message box and sets the alarm action for this sensor to No Action. (You can reset the alarm action from the Alarm tab 
of the sensor's Properties dialog box.)



Opens the property sheet for this sensor so you can review or change the sensor's properties.



Opens the application that can take corrective action appropriate to this alarm condition.



Histogram displaying several of the sensor's measurements collected over a period of time. The x-axis shows the elapsed time and 
the y-axis shows the units of the condition that the sensor is monitoring.



Shows the current sensor values, the results of the most recent sensor reading. You can change the frequency of sensor readings 
from the Measurement tab of the sensor's Properties dialog box.



Shows the highest value recorded by this sensor since it was first added or since the last time it was reset.



Shows the lowest value recorded by this sensor since it was first added or since the last time it was reset.



Shows the value at which the sensor's alarm action is triggered if the sensor alarm is enabled.



Shows the minimum reading possible for this sensor.



Shows the maximum reading possible for this sensor. The sensor uses the maximum to calculate relative percentages and display 
them in the graph. If this sensor has no absolute maximum, you can fix your own maximum as one of the sensor properties (using 
the Measurement tab); otherwise, the maximum is the same as the highest reading.



Saves any changes you have made within this tab and causes them to take effect immediately. This command button is unavailable 
until you have made one or more changes.



Checks for updates to this version of Norton Utilities. If updates are available, your copy can be automatically upgraded.



Displays a list of file types that the Virus Scan sensor will check for viruses. Use Add and Remove to modify this list.



Adds extensions to the list of file types that the Virus Scan sensor will check for viruses.



Removes extensions from the list of file types that the Virus Scan sensor will check for viruses.




